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Sweden* Denmark*
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* These locations are currently operating under the Ibas brand, which was acquired by Kroll Inc in 
2006.
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INTRODUCTION

INTRODUCTION

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

Welcome to Kroll Ontrack® Administrative Server 6.0. This application is a framework that can 
host centralized services to multiple clients and provide both client and server support for 
Ontrack® PowerControls™ 6.0 and Ontrack® PowerControls™ ExtractWizard users. 

Kroll Ontrack Administrative Server (KOAS) includes:

• Server Configuration: You can monitor the active connections and available services, 
change ports, restart or stop server, and elect to be discovered in Active Directory.

• Mailbox Permissions Service: In order to reinforce your internal corporate security 
policies, you can restrict access in Ontrack PowerControls 6.0 to mailboxes contained 
within private EDB Exchange mailbox stores based on your authority. 

• Application Auditing Service: Activities performed as part of Ontrack PowerControls 6.0 
and Ontrack PowerControls ExtractWizard operations, as well as activities within Kroll 
Ontrack Administrative Server, are logged as part of an “audit trail.”

• Central Licensing Server: The Central Licensing Server (CLS) allows you to control the 
licensing of Ontrack PowerControls products where there may be multiple clients or 
restricted access to USB ports.

You can manage these services using the Kroll Ontrack Management Console, which is the main 
interface for using this product.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Kroll Ontrack Administrative Server 6.0 Enhancements

Kroll Ontrack Administrative Server 6.0 contains all the features and benefits of Kroll Ontrack 
Administrative Server 1.2 plus these exciting new and improved features: 

• Support for Windows Server® 2008 R2
• Support for Windows® 7 Professional, Enterprise, Ultimate
• Support for VMware® ESX 4.0
• KOAS 6.0 can act as a server to both Ontrack PowerControls 5.2 and Ontrack 

PowerControls 6.0 clients. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
System Requirements

Kroll Ontrack Administrative Server requires the following minimum system configuration:

• One of the following operating systems:
• Windows® XP Professional
• Windows Server® 2003 
Copyright © 2010 Kroll Ontrack Inc. 1



I N T R O D U C T I O N
System RequirementsINTRODUCTION
• Windows Server® 2008 Standard
• Windows Server 2008 Data Center
• Windows Server 2008 Enterprise
• Windows Server 2008 R2
• Windows® Vista Business
• Windows Vista Ultimate
• Windows Vista Enterprise
• Windows 7 Professional
• Windows 7 Enterprise
• Windows 7 Ultimate

Note:  The operating systems are required to have the latest service packs installed.

• The following virtual environments are supported:
• VMware® Server 1.0x, 2.x
• VMware® Workstation v6.0x for Windows
• Microsoft® Virtual Server™ 2005 R2
• Microsoft® Hyper-V Server™ 2008 
• Microsoft® Virtual PC 2007
• VMware® ESX 4.0, ESXi

Note:  Kroll Ontrack Administrative Server is not supported on Windows Vista, Windows 
Server 2008, Windows Server 2008 R2, and Windows 7 64-bit virtual operating systems.

Note:  HASP key operation is validated in environments that support USB attached devices 
and support the Kroll Ontrack-distributed HASP drivers only.

• Microsoft® .NET Framework 3.5: System must have .NET Framework 3.5 installed in 
order to function.

• Intel® Pentium® 4 class or higher compatible processor 
• 2 GB RAM 
• 200 MB of free hard disk space for the installation. Additional disk space will be required to 

store log information as the system runs.
• Monitor with 800 x 600 or higher screen resolution 
• High-speed TCP/IP LAN network connection, minimum of 100 Mbps recommended.
• USB port (for Ontrack PowerControls product licenses requiring HASP key dongle to run 

application)
• Windows-based domain network environment. The system running KOAS, and all systems 

running Ontrack PowerControls for Exchange and Ontrack PowerControls ExtractWizard, 
must be joined to the same Windows-based network domain (or a trusted domain). Users 
must be logged in as a user of that domain when running Ontrack PowerControls for 
Exchange. To ensure correct operation, the KOAS Administrator should be logged in as a 
domain user with Administrator rights on the local system running KOAS, in order to install 
and configure KOAS. The domain account will also need authority to update Active 
2 Copyright © 2010 Kroll Ontrack Inc.
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Installing Kroll Ontrack Administrative Server
Directory (e.g. Domain Admin), if you wish to advertise KOAS services on Active 
Directory.

• In order to ensure correct operation of the Kroll Ontrack Administrative Server and any 
Ontrack PowerControls for Exchange and Ontrack PowerControls ExtractWizard clients, 
firewall solutions must be configured to allow communication on the TCP port KOAS is 
configured to use. The TCP port number can be configured via the Kroll Ontrack 
Management Console.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Installing Kroll Ontrack Administrative Server

Before you install KOAS, it is recommended that you consider your installation strategy including 
the availability of KOAS around the clock, the security KOAS will be providing and how your 
installation location could impact the level of security, and your available resources for application 
installation.

Installation Recommendations

Availability: It is recommended that the KOAS installation be on a distinct machine from Ontrack 
PowerControls. KOAS is a server and should be available 24/7. If KOAS is not available, Ontrack 
PowerControls and Ontrack PowerControls ExtractWizard will not function. A workstation with 
these applications running is far more likely to be rebooted in the course of normal work and 
shutdown overnight. KOAS can be run on an Exchange Server but because an Exchange Server is a 
mission critical system, especially for larger organizations, it isn’t recommended but is still up to 
you to decide.

Security: KOAS is the provider of security related services (auditing and mailbox permissions), so 
it would be best practice to separate the user and Administrator roles. Running Ontrack 
PowerControls and KOAS on the same system could compromise the integrity of the security 
provided by mailbox permissions and auditing functions. However, if the Administrator of KOAS 
is also a user of Ontrack PowerControls, having them both installed on the same machine makes 
sense.

Resources: KOAS is a server and needs sufficient resources to run efficiently. If your organization 
needs to run multiple installations of Ontrack PowerControls simultaneously, having a dedicated, 
server type system would service client requests more efficiently. Attempting to run KOAS on a 
system running other applications, such as Microsoft® Exchange Server or Ontrack 
PowerControls, could result in compromised or slower performance.

To install Kroll Ontrack Administrative Server

1. Turn off any disk utility or antivirus program running in the background.
2. Insert the Kroll Ontrack Administrative Server CD-ROM into your CD-ROM drive.
3. The installation program will automatically start. If it does not: 

• For Windows Server 2003 and earlier: Click Run on the Start menu, and type 
D:\autorun.exe or D:\bin\setup.exe, where D is the drive letter of your CD-ROM 
drive. Click OK.

• For Microsoft Vista, Windows Server 2008, and later: Click Run on the Start/All 
Programs/Accessories menu, and type D:\autorun.exe or D:\bin\setup.exe, where D 
is the drive letter of your CD-ROM drive. Click OK.
Copyright © 2010 Kroll Ontrack Inc. 3
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4. Follow the on-screen instructions.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Uninstalling Kroll Ontrack Administrative Server

You can uninstall Kroll Ontrack Administrative Server by running the uninstall program.

1. Click the Start button and then click Control Panel. (In Windows 2000 and earlier, you 
will point to Settings before you click Control Panel.)

2. In Control Panel: 
For Windows Server 2003 and earlier: Click the Add or Remove Programs icon.

• Click Kroll Ontrack Administrative Server, and then click Change/Remove.
• Click Yes when the confirmation dialog box appears.

For Microsoft Vista, Windows Server 2008, and later: Click Uninstall a program under 
the Programs heading.

• Click Kroll Ontrack Administrative Server, and then click Uninstall/Change.
3. Follow the on-screen instructions.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Upgrading Kroll Ontrack Administrative Server

KOAS 6.0 will upgrade an existing installation of KOAS 1.2. KOAS 6.0 will not upgrade existing 
installations of KOAS 1.1 or earlier.

Note:  During the upgrade, all data and configuration information is preserved.

If the Central Licensing Service (CLS) is in use, after an upgrade it is necessary to configure CLS 
to use your new Ontrack PowerControls 6.0 CLS license. After upgrading, the original Ontrack 
PowerControls 5.2 license will still be configured for use; however, this is not compatible with 
KOAS 6.0 and as a result the CLS plug-in status will indicate an error. 

To configure the CLS license file and correct this issue

1. Using the KOAS CLS plug-in, in the License File tab, configure KOAS 6.0 CLS to use the 
Ontrack PowerControls 6.0 CLS license file for Ontrack PowerControls.

2. Follow the instructions and restart KOAS to ensure that CLS is running properly. If the 
wrong CLS license file is configured, an error displays in the CLS status displays.
4 Copyright © 2010 Kroll Ontrack Inc.
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Getting Help
Figure 1-1. Incompatible Version

Understanding CLS Interoperability and Compatibility

KOAS 6.0 provides services for both Ontrack PowerControls 6.0 and Ontrack PowerControls 5.2.

Other versions of Ontrack PowerControls are not supported. If an attempt is made to use other 
versions of Ontrack PowerControls with KOAS 6.0 for CLS, the Ontrack PowerControls 
application displays an error.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Getting Help

Ontrack provides you with the following ways to get help for Kroll Ontrack Administrative Server: 

Online Help

Online Help includes all of the information in the user guide and more, and it lets you quickly 
access this information by using one of three tabs. The Contents tab offers a hierarchical view of 
the contents of the user guide. The Search tab offers a full-text search of the user guide. The Index 
tab offers a keyword-based way to get to specific topics.

To start online Help

Do one of the following:

• On the Help menu, click Contents.
• Press the F1 key.
Copyright © 2010 Kroll Ontrack Inc. 5
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Technical Support

If you have questions or problems not answered in the user guide or the online Help, call our 
Technical Support group. When reporting an issue, please include any information that might help 
us diagnose the problem. The following details are often the most helpful:

• The version of Kroll Ontrack Administrative Server you are using (on the Help menu, click 
About).

• The versions of Windows that you are running.
• The version of Exchange Server that contained the Source EDB file.
• The circumstances and sequence of steps that led to the problem.
• The text of the error messages (if any appeared), and the contents of the Details window.
• A list of other Windows programs that you were running when the error occurred.

Contact Information

See “U.S. Contact Information” and “International Contact Information” at the beginning of this 
user guide.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Conventions in this Manual

This manual uses guidelines for commands available on the shortcut menu and in notes and tips. 

Shortcut Menu

You can access many of the same commands available on the menu bar by right-clicking the mouse 
to display a shortcut menu. This manual seeks to teach you how to use commands on the menu bar, 
and doesn’t always specify when you can use the shortcut menu. Once you become familiar with 
Kroll Ontrack Administrative Server, the commands available to you on the shortcut menu should 
become apparent.

Notes and Tips

The notes and tips in this user guidefollow the guidelines offered in the Microsoft Manual of Style 
for Technical Publications, 3rd Edition. Redmond, WA: Microsoft Press, 2004.
6 Copyright © 2010 Kroll Ontrack Inc.



CHAPTER 1

. . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
ADMINISTRATIVE SERVER CHAPTER 1 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

Kroll Ontrack® Administrative Server (KOAS) activates mailbox permissions, centralizes multiple 
product licensing, and provides auditing services for Ontrack® PowerControls™ for Exchange and 
Ontrack® PowerControls™ ExtractWizard client and server. 

When you launch Ontrack PowerControls 6.0, it attempts to connect to Kroll Ontrack 
Administrative Server if it is activated. Kroll Ontrack Administrative Server is located 
automatically using a Service Connection Point (SCP) in the Active Directory, or a server whose 
details have been manually provided by you.

After connecting to the server, Ontrack PowerControls can utilize the services you have opted to 
activate—mailbox permissions service, central licensing service, or application auditing service. 
These services are configured and monitored using the Kroll Ontrack® Management Console 
(KOMC).

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Looking at the Kroll Ontrack Management Console

The Kroll Ontrack Management Console is the main user interface that allows you to configure and 
monitor KOAS and the installed services. You can use the KOMC to configure services and 
determine whether or not they are active and therefore made available to clients.

Multiple clients can simultaneously use the services hosted by the server. At a minimum, it 
supports 50 concurrent users.

KOAS opens to the Kroll Ontrack Management Console which contains a Server configuration 
button, the installed services buttons, and configuration pages for each service.
Copyright © 2010 Kroll Ontrack Inc. 7



A D M I N I S T R A T I V E  S E R V E R
Looking at the Kroll Ontrack Management ConsoleCHAPTER 1
Figure 1-1. Kroll Ontrack Management Console main window

Menu Bar

In the menu bar, the options of Plugin Activation and Deactivate plugins are available under the 
Tools menu.

Figure 1-2. Plugin Activation/Deactive Plugins options

PLUGIN ACTIVATION

If you deactivate or skip a plugin during the KOAS finalization (on KOMC first run), you can 
activate it with the Plugin Activation menu item. Any deactivated/skipped plugins activate as a 
result of selecting this option.

After selecting this option, KOMC checks to see if any plugin is currently active. If the plugin is 
active, its finalization window appears.
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Looking at the Kroll Ontrack Management Console
Figure 1-3. Example of finalization window for Auditing

After you click Finish, KOMC moves onto the next inactive plugin (if there is one). Once all 
plugins are activated, a message appears stating that KOAS needs to be restarted for changes to 
take effect.

Figure 1-4. Confirm activation message

If you click Yes, the server restarts and the newly activated plugins are available, both for 
configuration and management within KOMC and for client use. 

If you click No, the server does not restart and the plugin(s) are not activated until the server is next 
restarted (for example, by clicking the Restart button on the server configuration page or by 
rebooting the system). See “Server Operation” on page 12 for more information.

DEACTIVATE PLUGINS

You can use the Deactivate Plugins menu item to deactivate any currently active plugins. The act of 
deactivation removes the plugin from the KOMC so it cannot be configured or managed, and 
prevents client applications from using the service they provide. After you select Deactivate 
Plugins from the Tools menu, the Plug-in deactivation window appears.
Copyright © 2010 Kroll Ontrack Inc. 9
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Figure 1-5. Plug-in deactivation window

Deselect the plugin or plugins that you wish to deactivate. After you click OK, a message appears 
stating that KOAS needs to be restarted for changes to take effect.

Figure 1-6. Confirm deactivation message

If you click Yes, the server restarts and the deactivated plugin(s) are no longer available, either for 
configuration/management or for client use. If you click No, the server does not restart and the 
plugin(s) are not deactivated until the server is next restarted (for example, by clicking the Restart 
button on the server configuration page or by rebooting the system). See “Server Operation” on 
page 12 for more information.

Plugin deactivation (skipping during finalization) can be useful if you determine you want just one 
service but not the other. For example, your organization needs to audit activity, but does not need 
to enforce access permissions for mailboxes contained within EDB files.
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Kroll Ontrack Management Console First Run Configuration

After installation, when KOMC is run for the first time, it will prompt you to finalize the 
installation. 

Figure 1-7. Finalize installation

If you click No, KOMC closes and clients will not be able to connect. If you click Yes, KOMC 
finalizes each of the plug-ins. For details on the finalization for Mailbox Permissions and 
Applications Auditing, see “Mailbox Permissions Service First Run Configuration” on page 17 and 
“Audit Service First Run Configuration” on page 68.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Server Configuration Page

The Server Configuration page is available by clicking the Server button in the main window of 
Kroll Ontrack Administrative Server. The right pane contains three tabs that you can use to 
configure the server, view the configuration settings, and monitor the activity of the services.

Server Configuration Tab

The Server Configuration tab displays your server machine name, the server address, the port 
number, whether the server is advertised on Active Directory, the server up time which displays 
how long the Kroll Ontrack Administrative Server has been running in the current session, and the 
number of connections.
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